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Preface
Safety Notes
Your Xerox WorkCentre XK35c/25c and Xerox supplies are designed and
tested to meet strict safety requirements. Included are safety agency
examination and approval and compliance to established environmental
standards. Please read the following instructions carefully before operating
the WorkCentre XK35c/25c, and refer to them as needed to ensure the
continued safe operation of your WorkCentre.
Follow all warnings and instructions marked on or supplied with the product.
Unplug the WorkCentre from the wall outlet before cleaning. Always use
materials specifically designated for this product. Use of other materials may
result in poor performance and could create a hazardous situation.
Do not use aerosol cleaners. Follow the instructions in this User Guide for
proper cleaning methods. Never spray anything onto or inside of the
WorkCentre.
Use supplies or cleaning materials only as directed. Keep all supplies and
materials out of reach of children.
Do not use the WorkCentre near water, in wet locations, or outdoors.
Do not place the WorkCentre on an unstable cart, stand, or table. The
WorkCentre may fall, causing personal injury or serious damage to the
machine.
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Safety Notes (continued)
This product is equipped with a grounding type plug. The plug will fit only
into a grounded power outlet. This is a safety feature. To avoid risk of
electric shock, contact your electrician to replace the receptacle if you are
unable to insert the plug into the outlet. Never use an adapter to connect the
WorkCentre to a power source receptacle that lacks a ground connection
terminal.
The WorkCentre should be operated from the type of power source indicated
on the label. If you are not sure of the type of power available, consult your
local power company.
Do not allow anything to rest on the power cord. Do not locate the
WorkCentre where people will step on the cord.
The power supply cord is the disconnect device for this equipment. The
On/Off power switch does not electrically disconnect the machine from its
power source. You must unplug the power supply cord to electrically
disconnect the WorkCentre. Ensure that the WorkCentre is installed near an
outlet and is easily accessible.
Your machine is equipped with an energy saving device to conserve power
when the machine is not in use. The machine may be left on continuously.
Slots and openings in the cabinet and in the back and sides of the
WorkCentre are provided for ventilation. To ensure reliable operation of the
WorkCentre and to protect it from overheating, these openings must not be
blocked or covered. The WorkCentre should never be located near or over a
radiator or heat register. The WorkCentre should not be placed in a built-in
installation unless proper ventilation is provided.
Never push objects of any kind into the slots of the WorkCentre as they
may touch dangerous voltage points or short out parts which could result in a
fire or electric shock.
Never spill liquid of any kind on the WorkCentre.
Never remove covers or guards that require a tool for removal. There are
no casual operator serviceable areas within the covers of the WorkCentre.
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Safety Notes (continued)
Never defeat interlock switches. This WorkCentre is designed to restrict
operator access to unsafe areas. Covers, guards, and interlock switches are
provided to ensure that the machine will not operate with covers opened.
Use of an extension cord with this WorkCentre is not recommended or
authorized.
Avoid direct viewing of the document lights. The lamps are bright and,
while not harmful, they may cause an annoying afterimage. Always keep the
document cover closed during operation and storage.
If you need additional safety information concerning the WorkCentre
XK35c/25c or Xerox supplied materials, you may call the following toll-free
number.
In the United States or Canada: 1 - 800 - 828 - 6571
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Helpful Hints
WorkCentre Location
For reliable operation and copy quality, Xerox recommends:
n

Locate your WorkCentre in a well-ventilated room.

n

Place the WorkCentre on a flat, level surface.

n

Do not block any WorkCentre vents or openings.

n

Keep the WorkCentre environment at 60 to 90 F (16 to 32 C) and
40% to 70% humidity.

n

Avoid locating the WorkCentre in direct sunlight or extreme changes in
temperature or humidity.

o

o

o

o

Care of Your WorkCentre

viii

n

Clean the WorkCentre Document Glass daily or as required.

n

Apply cleaning liquids to a cloth first before applying cleaners to the
WorkCentre.

n

Store media in a dry area, on a flat surface and in a closed cabinet.

n

Wrap partially used reams of media tightly.
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Calling for Service and Supplies
Service
A Xerox Customer Support Center Representative will assist you in keeping
your WorkCentre operational and, if required, will arrange for service. Call
one of the following numbers for service. Have your model and serial
numbers handy. These numbers are found on the Xerox label on the middle
lower back of the machine.
Model

Xerox WorkCentre XK35c or XK25c
f i l l

i n

Serial Number
Country

Phone

USA or Canada

1-800-TEAM XRX, or 1-800-832-6979
(your country)

Visit the Xerox Web site at http://www.xerox.com for additional product
information.

Supplies
To order supplies for your WorkCentre, call or visit your local retailer or visit
their Web site. If your store does not stock these items, you may call the
following number.
In the United States and Canada:
Xerox SupplyNet toll free at: 1 – 800 – 822 – 2200
Part Numbers for Consumables:
Black Ink Cartridge: 8R7881
Color Ink Cartridge: 8R12591
CAUTION: Non-Xerox ink cartridges will not fit correctly into the
WorkCentre cartridge compartment, and may damage the machine.
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It's Illegal
In the USA
It is against US law to copy copyrighted material without permission of the
copyright owner unless the copying falls within the "Fair Use" or library
reproduction rights of the copyright law. Further information on these U.S.
provisions may be obtained from the Copyright Office, Library of Congress,
Washington, D.C. 20550, or telephone the Copyright Office at (202) 7079100 and ask for circular 21. Copying of other items may be prohibited. If
you have any questions, seek legal advice.

In Canada
In Canada it is against the law to copy copyrighted material without
permission of the copyright owner, unless the copying falls within the private
study, research or criticism provision of the copyright law. Copying of other
items may be prohibited. If you have any questions, seek legal advice.

x
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Machine Registration
In order to activate your WorkCentre warranty, please take a moment to
register this product. Use one of the following methods:
n

FAX your registration (model number, serial number and date of
purchase) to 1-800-594-5023, or

n

Mail in the registration card (the mailing portion of the Warranty Card), or

n

Call 1-800-TEAMXRX (1-800-832-6979)

You will need the model number, serial number and date of purchase when
registering your WorkCentre.
NOTE: Save a copy of the registration card and the bill of sale as proof of
purchase for future reference.
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System Requirements
Proper operation of the WorkCentre for printing (XK35c and XK25c) and
scanning (XK35c only) requires that your PC meets or exceeds the following
system requirements:
n

IBM compatible personal computer:
l

l

Minimum configuration: 486DX, 200MHz, 16 MB RAM, 20 MB free
hard disk space*, Windows 3.1x
Recommended configuration: Pentium II, 200MHz, 32 MB RAM,
20 MB free hard disk space*, Windows 3.1x
®

®

®

n

Windows operating environment (Windows 3.1x, Windows 95,
®
®
Windows 98, Windows NT 4.0)

n

16 MB or more RAM (Windows 3.1x), 32 MB RAM (Windows 95, 98),
and 32 MB RAM (Windows® NT 4.0)

n

A USB cable is supplied for printing and scanning functions. If you do not
have a USB port on your PC and you want printing and scanning (XK35c
only) functions, you must supply an IEEE 1284 bi-directional parallel
cable, maximum 6 feet.

®

®

* 20 MB minimum hard disk space required for driver installation only. If
installing the additional software, an additional 90MB free hard disk
space is required (70MB for Pagis Pro®, 20MB for MGI PhotoSuite®).
Xerox provides a print driver, TWAIN scanner driver and Control
Program (for ink cartridge management). Pagis Pro and MGI PhotoSuite
are provided (XK35c only) if you do not already have a scanner/image
editor program; these two software applications require Windows 95/98
or NT 4.0.

xii
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1. Getting Started
This section describes the installation and setup of your WorkCentre. The
following topics are included:
Page

Components ..................................................................... 2
Control Locations.............................................................. 3
Control Panel.................................................................... 5
Setup................................................................................ 8
Installing & Aligning Ink Cartridges ................................. 11
Using the Automatic Paper Feeder (APF)....................... 14
Loading Paper .................................................................. 14
Loading Envelopes ........................................................... 15

Using the Manual Paper Feeder ..................................... 16
Using the Menu Button ................................................... 17
Changing Ink Cartridges ................................................... 17
Aligning Ink Cartridges...................................................... 17
Setting Paper Size Using the Control Panel ...................... 18
Testing the Print Nozzles .................................................. 18

Paper Guidelines ............................................................ 19
Paper Selection ................................................................ 20
Guidelines for Special Paper and other Media .................. 21
Transparencies and glossy photo paper............................ 21

Installing Software .......................................................... 22
Overview of WorkCentre Software .................................... 22
General Installation........................................................... 23

Uninstalling Software ...................................................... 24
Windows® 3.1x ................................................................. 24
Windows® 95/98, or Windows® NT.................................... 24

Xerox XK35c/25c User Guide

1

Components
The following components are provided with your WorkCentre. Please
examine the carton contents. If any component is missing, contact the Xerox
Customer Support Center (see Calling for Service and Supplies).

WorkCentre
Documentation:
n User Guide
n Warranty
Registration Card
n Quick Reference
Card

Ink cartridges:
n Color #8R12591
n Black #8R7881

Set of CD-ROMs
(3 for XK35c)
(1 for XK25c)

AC Power cord

USB cable

NOTE: The black ink cartridge that is initially supplied with the WorkCentre is
a standard capacity cartridge. This initial black cartridge may run out of ink
before the low ink Diagnostic Display LED turns on. Replacement black
cartridges (#8R7881) are high capacity.
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Control Locations
Take a moment to familiarize yourself with the machine’s components and
controls and their locations.

Automatic Paper Feeder tray extension

Platen cover

Scanner module

Control Panel
Display

Output tray extension
Extender

Automatic Paper Feeder tray extension

Automatic Paper Feeder tray

Automatic Paper Feeder side paper guide

Manual Paper Feeder guide

Manual Paper Feeder
Automatic Paper Feeder envelope guide

Getting Started

3

Control Locations (continued)

Scanner module

Cartridge compartment lid/support

Ink cartridge carrier access

Control Panel

Lower left back of machine
Spare ink cartridge compartment
AC power cord socket

Lower right back of machine
On/Off power switch

USB port

IEEE 1284 Parallel port
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Control Panel
Use the following graphic to locate the buttons, Diagnostic Display LEDs and
Display on the WorkCentre Control Panel.
9

1

2

3

1 Resolution

4

10

5

6

13

8

Normal

Draft

Press to lighten or darken the image appearance.
Lighten

3 Media Type

7

12

Press to select the print resolution.
Best

2 Contrast

11

Normal

Darken.

Press to choose the media type to be used.
Transparencies
Glossy paper
Coated paper

Ä

Plain paper
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4 Special Copy

Press to set an option.
Fits multiple copies on one sheet (clone).

Auto

Reduces or enlarges the original to fit paper size.

100%

Makes a copy the same size as the original.

5 Copy Size/Scroll

Press and hold one of these two buttons to reduce
or enlarge the copy size from 25% to 400% of the
original document in 1% increments. Also used to
scroll through the menu choices as shown in the
Display.

6 Diagnostic

Lights up when color cartridge ink level is low.

Display
LEDs

Lights up when black cartridge ink level is low.
Lights up when a paper jam occurs or the paper
feeder is empty.

7 Number of Copies Press to set the number of copies from 1 to 50.
8 B&W/Color Mode

Press to alternate between black and white mode
and color mode.
Black and white mode
Color mode

9 Percent button

Press to change the Display. When this % LED light
is on, the Display shows the current copy size. When
the LED light is off, the Display shows the current
status of the machine.

10 Display

Used to display machine status, copy size, menu
codes and error codes.

Ä
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11 Menu

Press this button to enter Menu Mode. Each time
you press this button, the Display shows the menu
code:

U01

Change cartridges

U02

Align cartridges

U03

Set paper size

U04

Ink nozzle self test/cleaning

12 Start

Press to start operation or activate your selection.

13 Stop/Cancel

Press to stop an operation or cancel a selection.
This action restores all copy menus to default
settings in standby mode.

Getting Started
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Setup
Use the following procedure to initially set up your WorkCentre.

1 Open the shipping carton on a flat, stable surface. Remove all packing
materials and components. Check the set of components with the
component list. If any components are missing, call 1-800-TEAM XRX
(1-800-832-6379).

2 Remove the wrapping from the machine, and place the machine in its
work location. To help guarantee trouble-free operation of your machine,
place it on a flat, stable surface near your workstation. Leave enough
space to allow for easy paper loading, paper unloading, and opening of
the front cover.
NOTE: Do not place your machine:
u In direct sunlight.
u Near heat sources or air conditioners.
u In dusty or dirty environments.

3 Carefully remove the shipping tapes from the machine: the paper exit
tray in the front bottom area, both top sides and the paper feeder tray in
the back of the machine.

Paper exit tray

Top side

Paper feeder tray

4 Pull the extension tray upwards out of the Automatic Paper Feeder until
it snaps into place. Also pull the paper exit tray outward from the front
base of the machine. Fold out the extender from the paper exit tray
when copying or printing.

Ä
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5 Attach a printer cable.
n

USB cable (only for Windows 98 PCs): Plug one end into the USB
port on the back of the WorkCentre, and the other USB cable end
into the USB port on your PC.

Or
n

Parallel cable (not supplied, use IEEE 1284 cable for bi-directional
communications): Plug one end of the parallel cable into the
matching parallel port on the back of the WorkCentre, and plug the
other end of the parallel cable into the matching parallel port on your
PC. Swing the two wire clips on the sides of the WorkCentre parallel
port inward until they lock firmly inside the notches on the parallel
cable connector. Refer to your computer documentation for
assistance with this parallel cable procedure.

CAUTION: Use only one cable – USB or parallel cable. If your PC
does not have both a USB port and Windows 98, you must use a
parallel cable.

Wire clip

Parallel port

USB port

6 Plug one end of the supplied AC power cord into the power socket on
the back of the machine. Plug the other end into a standard AC power
outlet.

AC power cord socket

Ä
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Setup (continued)
7 Turn the WorkCentre power switch on. The switch is located on the rear
of the machine, next to the printer ports. Pressing the right, outer side
turns the power on; pressing the left, inner side turns the power off.

Power switch

8 The Control Panel Display will show 000 in a scrolling manner while
the machine is initializing.

9 The Control Panel Display will show 001 when it is ready for use.
Control Panel mode indicators are set to default values for this setup
procedure. When you first power the machine on and there are no
cartridges installed, you will see the error code E02 shown in the
Display. This means there is no left (color) cartridge installed. This error
code will disappear when you start the next procedure.

10 Proceed to the next step Installing & Aligning Ink Cartridges.
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Installing & Aligning Ink Cartridges
Your machine is a dual cartridge inkjet printer. You must use a black ink
cartridge and a color ink cartridge. When viewed from the front of the
machine, the color ink cartridge is installed in the left cartridge holder and the
black ink cartridge is installed in the right cartridge holder. Use the following
procedure to install the two ink cartridges and align them.
When installing ink cartridges, you must provide specific information to the
WorkCentre about the cartridges you install. This allows the printer to monitor
ink cartridge utilization.
There are two methods of entering cartridge information.
n

Using the WorkCentre Control Panel buttons

n

Using the WorkCentre Control Program software and a PC

The procedures in this section describe ink cartridge installation without
using the WorkCentre Control Program. To install ink cartridges using the
WorkCentre Control Program, see Section 5 Maintenance/Control Program.

1 Load sheets of paper (8.5 x 11 inches) into
the Automatic Paper Feeder against the right
edge of the paper feeder. Squeeze the side
paper guide with two fingers to release the
guide, and slide the guide all the way to the
left side of the paper tray.
Ensure that the guide is against the left edge
of the paper. For best results, use high
quality xerographic copy paper or inkjet paper.

2 Open the entire scanner module (not just the document cover) by lifting
the front edge upwards.

3 Support the scanner module by lifting the cartridge compartment
lid/support up so the scanner module rests on the top edge of the
lid/support.

4 Press the Menu button. A U01 message will appear in the Display.
Press Start. The cartridge holder will move left to the open change area.
The L-C message (left cartridge) will appear.

Ä
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Installing & Aligning the Ink Cartridges (continued)
5 Unpack the black ink cartridge. Remove the sealing tape.
NOTE: Hold the cartridge carefully. Do not
touch the electrical contacts on the side and
bottom of the cartridge. Ensure that there are
no pieces of tape remaining on the cartridge.

6 Insert the black cartridge down into the
cartridge holder on the right side of the carrier assembly. Push the
cartridge toward the back of the machine until it snaps into place.

7 Unpack the color ink cartridge. Remove the sealing tape.
8 Insert the color cartridge down into the
cartridge holder on the left side of the carrier
assembly. Push it toward the back of the
machine until it snaps into place.

9 Close the cartridge compartment lid/support
and scanner module.

10 The L-C message (left cartridge) still appears in the Display. Press
Start to indicate you have just installed the color ink cartridge in the left
cartridge holder. Pressing Stop indicates that a new color ink cartridge
was not installed (this avoids the alignment procedure).

11 The r-C message (right cartridge) will appear in the Display. Press
Start to indicate you have just installed the black Ink cartridge in the right
cartridge holder. Pressing Stop indicates that a new black Ink cartridge
was not installed (this avoids the alignment procedure).

Ä
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Installing & Aligning the Ink Cartridges (continued)
12 If you pressed Start to either of the two LED messages, the alignment
procedure will start. An alignment test pattern sheet will print during
which time the Display will show L-P . Review this sheet in response
to the next series of six LED messages. See an illustration of the
alignment sheet in Section 5 Maintenance/Cartridge Alignment.

13 For the first alignment message, the Display will show “A” plus a number,
as, A15 . Look this number up on the alignment sheet. If the printed
lines associated with this number are aligned better than any of the other
printed lines in group “A”, press Start. If there is another set of printed
lines that are aligned better, press the appropriate Copy Size/Scroll
button until the number associated with the best-aligned set appears in
the Display. Press Start.
NOTE: The machine will time out after one minute if Start is not pressed,
and will return to Standby Mode. The Display will then show 001 .
Press Menu repeatedly until you see the code U02 displayed, then
press Start to repeat the cartridge alignment process.

14 The Display will show the next alignment message in the series. Repeat
step 13 for these remaining five steps, from “B” through “F”.

15 The Ink Cartridge alignment is completed. Proceed to the next section
Using the Automatic Paper Feeder.
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Using the Automatic Paper Feeder (APF)
Loading Paper
You can load paper, envelopes, card stocks, labels, or transparencies in the
Automatic Paper Feeder. If there is no paper loaded and you attempt to copy
or print, the error message E01 will appear in the Display. The Automatic
Paper Feeder can hold a maximum of 100 sheets of plain paper, or 10
envelopes or other print media. Depending upon media thickness, maximum
capacity may be reduced.
NOTE: If you experience problems feeding any media in the Automatic Paper
Feeder, place the media into the Manual Paper Feeder one sheet at a time.

1 Pull the Extension Tray on the Automatic Paper Feeder all the way up
until it snaps into place.

2 Prepare the print material for loading. For paper, flex paper back and
forth. For transparencies, fan the stack to prevent feeding failures. Do
not fold or crease the paper. Straighten the edges on a level surface.
NOTE: For transparencies, be sure to use transparency stock approved
for use with inkjet printers. Refer to the packaging for the transparency
stock to determine the print side. Hold the transparencies by the edges
and avoid touching the print side. Be careful not to scratch or leave
fingerprints on the print side.

3 Load the sheets in the Automatic Paper Feeder. It is located behind the
Manual Paper Feeder. Ensure that the right edge of the media is in
contact with the right side of the feeder. Do not exceed the rated
capacity. Do not mix different types of print media. Refer to the following
instructions for loading each type of print material.
n

Load paper or transparencies with the print side facing you.

n

Load letterhead paper with the design side facing you. The top edge
of the sheet with the logo should enter the printer first.

n

Load 3-hole paper with the hole punches on the left side when
printing in landscape orientation or right side (portrait orientation) and
the print side facing you.

Ä
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Using the Automatic Paper Feeder/Loading (continued)
4 Move the side paper guide to the right while squeezing the tab on the
side paper guide. Slide the side paper guide until it lightly touches the
side of the print media.
NOTE: Do not press the guide too tightly to the edge of the print media.
The guide may bend the media or prevent the media from feeding.

5 When you print a file from your PC using the Automatic Paper Feeder,
make sure that you select the source and the correct paper size from
your PC software application before starting your print job. You can also
set paper size at the Control Panel.

Loading Envelopes
When printing envelopes, remember to use
the envelope guide in the Automatic Paper
Feeder.
To load envelopes:

1 Pull the envelope guide out towards you
until it snaps into place at a right angle
to the paper tray.

2 Load envelopes with the address side facing you. The end of the
envelope with the stamp area must enter the feeder first. The right edge
of the envelope must align with the raised edge of the envelope guide.

3 Squeeze the side paper guide and move it to the right until it lightly
touches the envelopes.
NOTE: If envelopes jam while printing, try reducing the number of envelopes
in the Automatic Paper Feeder. Fan the envelopes back and forth.

CAUTION: Do not feed stamped envelopes. Never use envelopes with
clasps, snaps, windows, coated linings, or self-stick adhesives. These
envelopes may severely damage the printer.
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Using the Manual Paper Feeder
The Manual Paper Feeder is located in front of the Automatic Paper Feeder.
Use the Manual Paper Feeder to feed paper one sheet at a time into your
machine.
When you print a file from your PC using the Manual Paper Feeder, ensure
that you select the source and the correct paper size from the Control Panel
or your PC software application before starting your print job.

1 Place the paper in the Manual Paper Feeder and adjust the Manual
Paper Feeder guide to the width of the print material.

2 Slide the guide to the right until it lightly touches the left edge of the print
media.
NOTE: Do not press the guide too tightly to the edge of the print media.
The guide may bend the media or prevent the media from feeding.

3 Ensure that the media is fed into the machine as far as it will go.

16

Getting Started

Using the Menu Button
The Menu button (located to the right of the Control Panel Display) is used
for ink cartridge functions. Each function is associated with a message code
starting with the letter “U”.
When you first press the Menu button, you will see the code U01 .
Repeated pressing of the Menu button will cycle through the codes. When
you select the function you want, press Start to begin the procedure. The
functions are:

U01 ..Changing cartridge
U02 ..Aligning the ink cartridges
U03 ..Setting paper size
U04 ..Ink nozzle self test/cleaning
NOTE: During any Menu operation, if you do not take any action (press any
buttons) for one minute, the machine will return to standby mode. The
Display will then show 001 .

Changing Ink Cartridges
Press the Menu button until you see the code U01 . See Installing &
Aligning Ink Cartridges earlier in this section or Section 5
Maintenance/Replacing Ink Cartridges for details.

Aligning Ink Cartridges
Press the Menu button repeatedly until you see the code U02 . See
Installing & Aligning Ink Cartridges earlier in this section or Section 5
Maintenance/Aligning Ink Cartridges for details.
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Setting Paper Size Using the Control Panel
You can load A4, letter or legal-sized paper. Your WorkCentre is preset to
letter size. If you load A4 or legal-sized paper, you must set the machine to
the correct paper size.

1 Press the Menu button on the Control Panel repeatedly until U03 is
shown in the Display.

2 Press Start. P01 is displayed (letter size).
3 If necessary, press one of the Scroll buttons to choose either P02 for
A4 paper or P03 for legal-sized paper.
4 Press Start to confirm the new setting.
Display

Paper Size

P01 .

Letter

P02 .

A4

P03 .

Legal

Testing the Print Nozzles
Press the Menu button repeatedly until you see the code U04 . See
Section 5 Maintenance/Clean Print Head Procedure for details.
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Paper Guidelines
When selecting or loading paper, envelopes or other special media, keep
these guidelines in mind:
n

Attempting to print on damp, curled, wrinkled or torn paper can cause
paper jams and poor print quality.

n

Use only high quality, inkjet-grade paper. Avoid paper with embossed
lettering, perforations or texture that is too smooth or rough.

n

Store paper in its ream wrapper until ready to use. Place cartons on
pallets or shelves, not on the floor. Do not place heavy objects on top of
the paper, whether it is packaged or unpackaged. Keep it away from
moisture, or other conditions that can cause it to wrinkle or curl.

n

Moisture-proof wrap (any plastic container or bag) should be used during
storage to prevent dust and moisture from contaminating your paper.

n

Always use paper and other media that conform to those listed under
Specifications in the Appendix.

n

Use only well constructed envelopes with sharp, well creased folds.
l
l

l

DO NOT use envelopes with clasps and snaps.
DO NOT use envelopes with windows, coated linings, self-stick
adhesives or other synthetic materials.
DO NOT use damaged or poorly made envelopes.

Getting Started
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Paper Selection
One of the most important things you can do to assure the best possible
printing performance of your machine is to select the correct paper. Your
machine produces letter quality print on most plain bond papers, including
cotton bond and photocopying papers; it does not require special ink jet
papers. However, the print quality varies with different paper types. Be sure
to test a type of paper before you purchase a large quantity.
Plain Paper
The machine supports paper sizes of letter, legal and A4 in portrait
orientation. You can use regular copier paper, cotton bond papers and typical
letterhead. Always use paper without curls, folds, staples or damaged
edges.
Inkjet Paper
This paper has been developed specifically for printing with inkjet printers. It
will produce high quality documents that compare favorably to those
produced with a laser printer.
Coated Paper
The coated paper has been developed for high quality printing with minimal
or no smearing or running when in contact with water or damp surfaces,
making it a good choice for damp or rainy environments.
Glossy Photo Paper
Glossy photo paper is a high gloss, thicker paper that produces the look and
feel of a photograph. Use this paper to produce photo-realistic prints.
Transparencies
Your transparencies will possess excellent contrast, sharpness and color.
Iron-on Transfers
Use inkjet T-shirt transfer paper to create and personalize T-shirts,
sweatshirts, aprons, tablecloths, napkins, tote bags, and anything else your
imagination allows! Use on any cotton or cotton/poly blend fabric. Follow
instructions that come with the transfer paper.
Greeting Card Stock
Get the most out of card making software with Greeting Cards. These cards
give your unique, personalized cards the look and feel of professional cards.
You can create cards, invitations, announcements and more.
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Guidelines for Special Paper and other Media
Be sure to read any instructions that come with your special paper. These
instructions provide important information regarding how to achieve the
highest print quality with these papers.
n

It is recommended that you feed special paper types one sheet at a time.

n

Store unused media flat. Do not remove papers from their protective
packaging until you are ready to use them.

n

Store unused media at temperatures between 59 and 86 degrees
Fahrenheit (15 to 30 degrees Centigrade). The relative humidity should
be between 10% and 70%.

n

If the print density of your page is very high, light paper stock may curl
slightly due to the large amount of ink. If you need to print dense
graphics, try printing on heavier stock.

n

Do not use thicker paper than meets the specifications for this machine.
Printing with a paper that is thick enough to come in contact with the print
head nozzles may damage the cartridge.

Transparencies and glossy photo paper
n

Let the printed sheets dry completely before storing them.

n

When a printed sheet has dried completely, cover the printed side with a
sheet of plain (not coated) paper before storing it; this is recommended
even if you place the sheets in a clear file or plastic holder.

n

Do not leave the sheets in the paper tray for long periods of time. Dust
and dirt may accumulate on the sheets resulting in spotty printing.

n

To avoid smudging caused by fingerprints, handle transparencies and
glossy photo paper carefully.

n

To avoid fading, do not expose the printed sheets to prolonged sunlight.

Getting Started
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Installing Software
Overview of WorkCentre Software
Before the WorkCentre can interface with your computer, you must install
print and TWAIN (scanner – XK35c only) driver files. These drivers will
enable your computer to properly communicate with the WorkCentre for
printing and scanning operations.
All of the necessary print drivers are contained on the Xerox CD-ROM
included with your WorkCentre.
Also included on the Xerox CD-ROM is the WorkCentre Control Program.
This program helps to manage the WorkCentre machine. See Section 5
Maintenance/Xerox WorkCentre Control Program.
In addition to the Xerox software, two optional software applications (XK35c
only) are included on separate CD-ROMs. These two applications work with
Windows® 95/98/NT 4.0, but not with Windows® 3.1X.
n

n

Pagis Pro® 2.0 - a suite of scanning applications. See Pagis Pro
documentation on the Pagis Pro 2.0 CD-ROM or Pagis Pro online Help
for details. You will need to install Pagis Pro using the setup.exe file on
the Pagis Pro CD-ROM if you do not have a scanning program installed
on your PC capable of using the XK35c scanner driver. See Section 3
Scanning.
MGI PhotoSuite® - a suite of graphics processing tools. See MGI
PhotoSuite documentation on the MGI PhotoSuite CD-ROM or MGI
PhotoSuite online Help for details. You can use this software for editing
any images scanned by the XK35c. You can install this software using
the setup.exe file on the MGI PhotoSuite CD-ROM.

When you complete the Xerox software installation, the following items will
be installed on your PC:
n

Print driver for printing

n

TWAIN driver for scanning (XK35c only)

n

Control Program for managing the WorkCentre

NOTE: When you install this software, make sure no other programs are
running.
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General Installation
1 Make sure the WorkCentre is connected to your PC.
2 Power on the WorkCentre.
3 Turn on your PC and start Windows.
4 Insert the WorkCentre CD-ROM into your CD ROM drive.
Installation for Windows® 3.1X continued…
5 From the File menu of the Windows Program Manager, select File>Run.
6 Type d:\Xinstall.exe (replace "d" with the letter designation of your PC’s
CD-ROM drive), and click OK. Continue with step 7.

Installation for Windows® 95/98 or Windows® NT 4.0 continued…
NOTE: For USB (Windows 98 only):
a) You will see an Add New Hardware dialog. Select NEXT.
b) Follow screen instructions to load USB driver. When asked for USB
driver source, point to Xerox CD. Continue with screen instructions.
c) Go to Step 5 to manually install the XK Series printer and TWAIN
drivers.

5 If AutoPlay is not enabled to automatically recognize the CD-ROM,
select Start>Run (Windows 95/98 and NT 4.0).

6 Type d:\Xinstall.exe (replace "d" with the letter designation of your PC’s
CD-ROM drive), and click OK. Continue with step 7.

General Installation continued…
7 The WorkCentre software installation program will begin. Follow the onscreen instructions for the rest of the installation.

8 Restart your PC to complete the installation process.

Getting Started
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Uninstalling Software
To remove the Xerox-supplied software from your PC:

Windows® 3.1x
1 In Windows 3.1x, all WorkCentre software components are installed into
a single program group.

2 Start Windows 3.1x.
3 In the Program Manager, double click on the WorkCentre XK Series
Program Group.

4 The WorkCentre Program Group will open.
5 Double click on the Program Group containing the component you wish
to uninstall.

6 The Program Group will open.
7 Double Click on the Uninstall icon.
8 The selected component is uninstalled.

Windows® 95/98, or Windows® NT
1 Start Windows.
2 Select Start > Programs.
3 Locate the Start Menu Program Item for the component you wish to
uninstall.

4 Click on the Submenu Uninstall icon for the component you wish to
remove.

5 A window will open prompting you to confirm that you wish to remove the
selected application.

6 Click Yes.
7 Uninstall Shield launches and the component is uninstalled.
8 Each software component must be uninstalled one at a time.
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2. Printing
This section describes printing from your PC to your Xerox WorkCentre. It
includes the following topics:

Page

Printing a Document From an Application....................... 26
Printer Settings ............................................................... 27
Windows 95/98 and 3.1x Printer Settings.......................... 28
Windows NT 4.0 Printer Settings ...................................... 28
Printer Properties Tabs..................................................... 29
Printer Properties Buttons & Icons .................................... 29
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Printing a Document From an Application
This procedure describes the general steps required for printing from various
Windows applications. The exact steps for printing a document may vary
depending on the application program you are using. Refer to your software
application’s documentation for the exact printing procedure.
The following steps describe the typical process to print from a Windows
environment:

1 Ensure that your WorkCentre is properly connected to the computer, the
machine is powered on, there is paper in one of the paper feeders and
the Display shows the message 001 .

2 Verify that you have installed the print driver software for your machine.
See Installing Software.

3 Start the program you are using to create the document, and create or
open the document you want to print.

4 Choose Print or Print Setup from the File menu. Make sure the
WorkCentre is selected as your default printer. Click Properties or
Setup if you want to make any adjustments that are appropriate for
printing your document. (See Printer Settings)

5 Click OK to close the Properties dialog box.
6 After making any necessary changes to the printing parameters, click OK
to start the print job.

7 During the printing process, the WorkCentre Display will show the
message PCP , and the WorkCentre Control Program tab menu will
appear on your PC screen showing printing progress.
NOTE: The WorkCentre supports DOS printing when the DOS application is
run within the control of the Windows MS/DOS dialog. See Section 5
Maintenance/Xerox WorkCentre Control Program for more information.
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Printer Settings
You can use your machine with all your Windows 3.1x, Windows 95/98 or
Windows NT 4.0 applications. Be sure to set the WorkCentre as the default
printer for all your Windows operations.
Most Windows software applications allow you to make changes to the
printer settings. This includes settings that determine how a print job looks
such as page size, paper orientation, and margins. Settings made in the
application to create the document will usually override settings made in the
printer driver.
All screen captures for the following section are from the Windows 95/98
environment.
NOTE: You do not need to use any of the Control Panel buttons to use the
machine as a PC printer. For example, if you are printing a color document,
you do not have to press the Color button on the Control Panel. The Control
Panel buttons are used primarily for copying.
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Windows 95/98 and 3.1x Printer Settings
You can access printer settings by using either of these methods:
n

Select the File>Print>Properties or File>Print Setup command from
within any Windows application. This method will provide access to the
Job Finishing, Paper, Document/Quality and Advanced tabs.
Or

n

Select the Xerox WorkCentre printer from the Printers folder, then select
File>Properties (or select the printer icon in the Printers folder, and click
the right mouse button). This method will provide access to the General
and Details tabs, as well as the Job Finishing, Page, Main, and
Advanced tabs.
NOTE: Windows 98 also shows the Color Management tab.

NOTE: In Windows 3.1x: Go into Print Manager and select the Xerox
WorkCentre printer; pull down the Options menu and select Printer
Setup. Click the Setup button to view the Page, Main, and Advanced
tabs.

Windows NT 4.0 Printer Settings
The Windows NT 4.0 printer drivers contain many of the same features as
the printer drivers for Windows 3.1 and Windows 95/98. However, the names
of the tabs and some of the features are different.
You can access the various printer settings by using either of these methods:
n

Select File>Print>Properties or File>Print Setup command from within
any Windows application. This provides access to the Page Setup,
Color, and Features tabs.
Or

n
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Select Xerox WorkCentre XK Series printer from the Printers folder,
click the right mouse button, then select Document Defaults from the
drop-down list. This provides access to the General, Ports, Scheduling,
Sharing, Security and DOS Printing tabs.

Printer Properties Tabs
When the Printer Properties are displayed, you can review and change
whatever settings are needed for your print job. If accessed through the
Printers folder, the Printer Properties Tab Menu consists of six tabs (seven
for Windows 98):
n

General tab - for viewing and changing general Windows 95 printer
information. See your Windows 95/98 User Guide for details.

n

Details tab - for viewing and changing port and timeout parameters. See
your Windows 95/98 User Guide for details.

n

Color Management tab - for adding and removing color profiles
associated with your printer. This tab is not shown in Windows 95, only
in Windows 98.

n

Job Finishing tab – for settings Finishing options of booklet, poster,
handout or two-sided printing.

n

Paper tab - for paper sources and sizes, number of copies, and
orientation.

n

Document/Quality tab - for document and paper types and for print
quality.

n

Advanced tab - this tab provides access to controls for print image
quality.

Printer Properties Buttons & Icons
n

Click OK when done reviewing or making changes.

n

Click Cancel if you want to exit the tab menus without applying any
changes.

n

Click Help to view the online Help feature and tab menu details.

n

Click the ? icon in the tab dialog menu bar. Position the ? pointer over
the parameter in question and click to see a pop up window explaining
that parameter.

n

Click the Defaults button to reset the parameter values for all tabs to
their default settings (i.e., before you made any pending changes).

n

Click the About button to view the date and version of the print driver
software.

Printing
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3. Scanning with
the XK35c
This section describes scanning with the Xerox WorkCentre XK35c. The
WorkCentre XK25c does not have a Scan To PC function. The following
topics are included:
Page

Scanning ........................................................................ 32
Starting the Scan Process .............................................. 32
Scanner Tab Menus ....................................................... 34
Tab Menu Image Window ................................................. 34
Using the Tab Menus........................................................ 34
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Scanning
You can scan a document with the XK35c. When you installed the XK35c
software, the TWAIN driver was also installed. By using a scanning program,
such as Pagis Pro (supplied by Xerox on a separate CD-ROM), you can use
the XK35c scan function.
While every scanning program is different, follow the basic steps outlined
here to invoke the scanner driver tab menus.

Starting the Scan Process
To start the scanning process:

1 Ensure that your WorkCentre XK35c machine is properly connected to
the computer, the machine is powered on and the Display shows the
message 001 .

2 Verify that you have installed the TWAIN driver software for your
machine. See Installing Software.

3 With your PC and Windows running, start your scan program. You may
have the program represented on your desktop with an icon, or it may be
accessed by selecting Start>Programs>[program name].

4 Select File>Acquire or Acquire Image>Select Source in the File menu
to bring up a list dialog. Select Xerox WorkCentre XK Series, then
select OK. If the Acquire command is not available, you will need to use
another scan program. The Pagis Pro software program provides an
Acquire function.

5 Select File>Acquire Image >Acquire to invoke the XK35c scanner
driver.

Ä
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6 Lift the platen cover, and place your
document on the document glass.

7 Once you have invoked the scanner
driver, the tab menu will be
displayed. Click the Scan button in
the tab menu to start the scan
process. When the scanning process
begins, the WorkCentre Display will
show the message PCS .
NOTE: If the scanning process does not begin, try lowering the
resolution rate in the tab menu, and repeat the scan step.

8 Once you have generated a scanned image, you can edit the image
using the image editor functions (e.g., MGI PhotoSuite), or print the
image using the Print function in the scanning program, or save the
image to disk using a function such as Save As in the scanning program.
NOTE: If you do not close the platen cover or do not contact the document
completely with the document glass, scanning quality will be severely
reduced.
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Scanner Tab Menus
Tab Menu Image Window
The Tab Menu displays an image window on the right half of the dialog
window. This image window has ruler reference lines for editing. The left half
of the dialog window contains the four tab menus and their parameters.
To scan, click the Scan button in the lower right corner of the tab menu.

Using the Tab Menus
The Basic Tab Menu is the first of the scanning driver tab menus, and
provides the features of:
n

Image Type

n

Resolution

n

Reduce/Enlarge

n

Descreen

n

Saved Settings

Click on this or the other tab menus to view and change any scanning
parameters.
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4. Copying
This section describes copying on your Xerox WorkCentre. It includes the
following topics:
Page

Features ..........................................................................36
Making One Quick Copy..................................................37
Using the Copy Menu Features .......................................38
Adjusting Resolution..........................................................38
Adjusting Contrast or Color Intensity..................................38
Selecting Media Type ........................................................39
Setting Special Copy Features...........................................39
Enlarging or Reducing the Image.......................................40
Choosing Color or B&W Mode ...........................................40
Using the Menu Button ......................................................41
Changing the Number of Copies ........................................41
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Features
Your WorkCentre is a high quality copier that offers the following features:

36

n

Adjustable Resolution – improves the clarity and sharpness of your
copies.

n

Adjustable Contrast – obtains the best copy quality for documents
containing faint markings or dark images.

n

Selectable Paper Type – obtains the best copy quality for transparency,
glossy paper, coated paper or plain paper.

n

Clone – multiple images can be printed on one sheet with this feature.

n

Autofit – allows you to reduce or enlarge the original to fit the paper you
are using.

n

Enlarge/Reduce – reduces or enlarges the copied image from 25% to
400% of the original document.

n

Multiple Copies – 1 to 50 copies of the document can be made.

n

B&W/Color Mode Selection – allows you to select color mode for a
color document.

Copying

Making One Quick Copy
Follow this procedure when you need to make one quick copy of your original
document.

1 Make sure the WorkCentre is powered on. Load paper in one of the
paper feeders. The Display should show the message 001 .
2 Open the platen cover. Make sure the
glass is clean. Load the document on
the document glass facing down and
pushed against the left and rear
guides.

3 Close the platen cover.

NOTE: If you do not close the platen cover or do not contact the
document completely with the document glass, scanning quality will be
severely reduced.

4 Press the Start button. The machine will make one copy with the
following features:
l

Normal resolution

l

Normal contrast

l

Plain paper type

l

100% copy size (same as original)

l

Single copy

l

Color mode

5 For other copy features and functions, see the next section Using the
Copy Menu Features.

Copying

37

Using the Copy Menu Features
This section describes all the WorkCentre features available for copying. Use
the copy menu buttons to change feature settings before pressing the Start
button to begin copying. When you press a feature button, the LED light
corresponding to the icon selected will turn on. To select the next option,
press the feature button again.

Adjusting Resolution
Each time you press the Resolution button, you can choose Best, Normal
or Draft mode.

Best mode is good for documents with fine detail. The
copy quality is very good but the copy speed is slow.
Normal mode works well for normal documents (text).
Draft mode can be used for fast copying with lower
resolution.

Adjusting Contrast or Color Intensity
In black and white mode, the Contrast button can adjust the contrast for a
document containing faint markings or dark images. In color mode, the
Contrast button adjusts the color intensity.

Low contrast is good for documents containing dark
images.
Normal contrast works well with standard documents.
High contrast works well with light print or faint pencil
markings.
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Selecting Media Type
Press the Media Type button to select the desired media type.
Transparency
Glossy paper
Coated paper
Plain paper

NOTE: Transparencies may be smeared if you store the
transparencies in a humid area for a long time.

Setting Special Copy Features
You can set the following special features by pressing the Special Copy
button.
Clone

Select Clone for automatically setting
multiple image copies on a single page.
The number of images is determined by
the original image size. See NOTE.

Auto

Select Auto to automatically reduce or
enlarge the original image to fit it on the
copy paper. See NOTE.

100%

Select 100% to enlarge or reduce the copy
image size, then use the Scroll buttons to
set the percent from 25% to 400%.

NOTE: When copying Multiple images per page or using
Auto, the copy size cannot be adjusted.

Copying
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Enlarging or Reducing the Image
You can reduce or enlarge the size of a copied image from 25% to 400% in
increments of 1% using the Copy Size/Scroll buttons.

% Button

Press the Percent button to alternate
between copy count and copy size
in the Display.

25%>400%
Copy Size/
Scroll
Buttons

Press down the upper or lower Scroll
button to increase or decrease image size
percent by 1% increments, or press and
hold to quickly decrease or increase the
image size percent. Press Stop to reset
the percent to 100%.

Choosing Color or B&W Mode
Each time you press the B&W/Color Mode button, Black&White and Color
modes are alternatively selected.

Select the top icon for Black and White copying.
Select the bottom icon for Color copying.
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Using the Menu Button
The Menu button provides a number of functions that let you manage
components of the WorkCentre. See Section 1 Getting Started/Using the
Menu Button for details.

Menu button

Changing the Number of Copies
You can set the number of copies from 1 to 50. The Control Panel Display
shows the selected number.

Press and hold down the Quantity button to quickly
increase the copy number, or press and quickly release
the button to increase the copy number by 1 each time
you press/release the button. Once the display reaches
50, further pressing of the Quantity button recycles the
number to 001. Press Stop to reset the count to 001.

Copying
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5. Maintenance
This section describes maintenance procedures for the Xerox WorkCentre. It
includes the following topics:
Page

Managing the Ink Cartridges........................................... 44
Tips for your ink cartridges................................................ 44
Clean Print Head Procedure ............................................. 44
Wiping the Ink Cartridge Nozzles and Contacts................. 47
Cleaning the Cartridge Carrier Contacts............................ 48
Replacing the Ink Cartridge .............................................. 49
Cartridge Alignment.......................................................... 51

The Xerox WorkCentre Control Program ........................ 54
Starting the Xerox WorkCentre Control Program............... 54
Xerox WorkCentre Control Program Tab Menus ............... 55

Cleaning the Scanning Glass.......................................... 56
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Managing the Ink Cartridges
Tips for your ink cartridges
To get the maximum benefit from your ink cartridges:
n

Do not remove an ink cartridge from its packaging until you are ready to
install it.

n

Do not refill the ink cartridge. The warranty will not cover damage caused
by using refilled cartridges.

n

Store the ink cartridge in the same environment as the printer.

n

Do not remove an ink cartridge from the printer except to replace it.
Immediately replace the ink cartridge or store it in the storage unit. The
ink cartridge will not print correctly if removed from the machine and left
exposed for an extended period.

n

Do not swap the color cartridge with the black cartridge. The color
cartridge should be installed in the Left carrier and the black cartridge
should be installed in the Right carrier.

n

If you have an opened ink cartridge you are not currently using and do
not have an available print cartridge storage unit, store it in an airtight
plastic bag. Do not leave it exposed to the air for an extended period; this
promotes drying out and clogging of the print nozzles.

Clean Print Head Procedure
You should test the print cartridge when the print is not clear or image
information is missing. The problem may be caused by blocked nozzles on
the ink cartridge.
This procedure cleans the ink cartridge by purging the nozzles. Then it prints
a test so you can see the results.
Use the procedure:
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n

When you suspect the nozzles are clogged.

n

When characters are not printing completely.

Maintenance

Cleaning the Print Head Nozzles From the Control Panel
This procedure cleans the print nozzles and removes any deposits that may
impair printing functions.
To run the procedure:

1 Press the Menu button repeatedly until the code U04 appears in the
Display. Ensure there is paper in the Automatic Paper Feeder.

2 Press Start.
The WorkCentre prints a head cleaning test pattern. Notice the series of
diagonal lines across the top and bottom of the test pattern. Breaks
within a line of the same color indicate a clogged nozzle. Try running this
procedure again if you see breaks in the diagonal lines. If the print quality
is satisfactory after running the test three times, the print nozzles are
clean.
If the print quality of the test pattern is still not satisfactory, go to step 3.

3 Remove and reinstall the print cartridge.
4 Repeat the Print Head Nozzle procedure.
5 If the diagonal lines are still broken, wipe the print cartridge nozzles. See
Wiping the Print Nozzles and Contacts.
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To clean the Print Head Nozzles from your PC:
In Windows 95/98 or Windows NT 4.0:

1 Go to Start>Programs>Xerox WorkCentre XK Series. Ensure there is
paper in the Automatic Paper Feeder.

2 Select Xerox WorkCentre Control Program on LPT1.
3 The Control Program window opens.
NOTE: For Windows 3.1: At system startup, open the Xerox WorkCentre
group from Program Manager. Double-click on the Xerox WorkCentre
Control Program icon.

4 Click the Cartridges tab, then click Clean Print Nozzles. The printer
feeds a sheet of paper and prints the nozzle test pattern.
NOTE: There are minor differences in the appearance of the Cartridges
Tab between Windows 95/98 and Windows NT 4.0
Examine the test pattern. Compare the diagonal same-color lines at the
top and bottom of the test pattern. Look for a break in the diagonal lines;
a broken line shows clogged nozzles.
If the bottom line shows improvement, rerun this test. If improvement
continues, rerun the test. If all nozzles are not printing after running the
test three times, continue with step 5.

5 If print quality does not improve, remove and reinstall the ink cartridge.
Repeat the Print Head Nozzle procedure.

6 If the line is still broken, wipe the nozzles and contacts. Refer to Wiping
the Ink Cartridge Nozzles and Contacts.
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Wiping the Ink Cartridge Nozzles and Contacts
If print quality does not improve after repeating the Print Head Nozzle
procedure, the problem may be caused by dried ink on the ink cartridge:
n

nozzles

n

contacts

n

carrier contacts in the printer

Follow this procedure:

1 Lift the scanner module. Lift the cartridge compartment lid/support up so
the scanner module rests on the top edge of the lid/support.

2 Press Menu until the code U01 appears in the Display.
3 Press Start. The cartridge carrier assembly will move into the open area.
4 Remove the ink cartridge. See Replacing the Ink Cartridge.
5 Use a clean, lint free cloth, dampened with water only, to gently clean the
entire copper colored area, including the nozzles and contacts. To
dissolve any dried ink, hold the damp cloth against the nozzles for about
three seconds. Gently blot and wipe dry.
NOTE: If you are cleaning a color ink cartridge, be especially careful to
wipe the nozzles in only one direction so the colors do not mix.

6 Allow the copper-colored area to dry, then reinstall the ink cartridge
7 Close the cartridge compartment lid/support and scanner module.
8 Repeat the nozzle test. See Cleaning the Print Nozzles.
9 If the line is still broken, clean the print cartridge carrier contacts in your
machine. See Cleaning the Cartridge Carrier Contacts.

10 If print quality still has not improved, replace the ink cartridge.
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Cleaning the Cartridge Carrier Contacts
1 Lift the scanner module. Lift the cartridge compartment lid/support up so
the scanner module rests on the top edge of the lid/support.

2 Press the Menu button until the code U01 appears in the Display.
3 Press Start.
4 Unplug the power cord from the rear of the WorkCentre.
5 Remove both ink cartridges.
6 Use a CLEAN, LINT FREE, DRY CLOTH to clean the ink cartridge
carrier contacts on the back wall of the carrier.

7 Reinstall the ink cartridges.
8 Close the cartridge compartment lid/support and the scanner module.
9 Plug the power cord into the WorkCentre.
10 Test the ink cartridges by running the Clean Print Head procedure. If the
print quality is still unacceptable, contact the Xerox Customer Support
Center at 1-800-TEAM XRX (see Preface/Calling for Service and
Support).
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Replacing the Ink Cartridge
The ink cartridge includes the ink supply and the print head. Each time you
replace the ink cartridge, you are replacing the print head as well.
When you notice the print becomes light or one of
the low ink Diagnostic Display LEDs lights turns on,
replace your cartridge.
NOTE: When either of the two ink cartridge
Diagnostic Display LED lights turns on during PC
printing, the machine continues printing. After PC
printing is completed, replace the ink cartridge. Your
machine counts ink droplets, and keeps ink low
counts for both ink cartridges.

Color
Black
Diagnostic Display LEDs

To replace the ink cartridge, perform the following steps:

1 Load paper into the Automatic Paper Feeder.
2 Lift and open the entire scanner module. Support the scanner with the
cartridge compartment lid/support.

3 Press the Menu button. A U01 message will appear in the Display.
4 Press Start. The cartridge assembly will move to the open change area.
5 The LCD window will display the L-C message. If you want to change
the left cartridge (color) press Start, otherwise press Stop. The message
will then change to message r-C . If you want to change the right
cartridge (black), press Start, otherwise press Stop.

6 Pull the handle of the ink cartridge(s) you want to replace toward you
until there is a click. Remove the ink cartridge(s).

7 Remove a new ink cartridge from its packaging and carefully remove the
tape covering the print head. Hold the ink cartridge by the colored tab or
black areas only. Do not touch the copper area.
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8 Insert the ink cartridge in the cartridge holder, then push the ink cartridge
firmly to the rear of the machine until it snaps into place.
If the ink cartridge moves loosely in the carrier, it has not snapped into
place. Repeat this step.

9 If you changed the left cartridge (color) press Start, otherwise press
Stop. The message will then change to r-C . If you changed the right
cartridge (black) press Start, otherwise press Stop.
If you pressed Start to either of the two LED messages, the alignment
procedure will start. An alignment test pattern sheet will print during
which time the LED display will show L-P .

10 Close the cover and proceed to the Cartridge Alignment procedure. Use
that particular procedure named To Align the Cartridge Using the
WorkCentre Control Panel, starting with step 4.
NOTE: If you are interrupted and leave the print carrier in the left side access
location for more than 30 minutes, the print cartridge carrier moves to the
standby position.
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Cartridge Alignment
You should print the cartridge alignment test if vertical lines or characters
appear crooked. The cartridge alignment test will straighten the vertical lines.

To Align the Cartridge from your PC:

1 Open the Xerox WorkCentre Control Program on LPT1. Refer to Starting
the Xerox WorkCentre Control Program and to Using the Cartridges Tab.

2 Click Align Cartridges.
3 The printer feeds a sheet of paper and prints the alignment test pattern.
4 Examine the test print.
If the vertical lines are straight, no adjustment is needed.
If the lines are not straight, select the number in which the lines appear
the straightest and click OK.

To Align the Cartridge Using the WorkCentre Control Panel:

1 Press the Menu button on the Control Panel repeatedly until the
Message Code U02 appears in the Display.
2 Press Start.
NOTE: The machine will time out after one minute if Start is not pressed,
and will return to Standby Mode. The Display will then show 001 .
Press Menu repeatedly until you see the code U02 displayed, then
press Start to repeat the cartridge alignment process.

3 An alignment test pattern sheet will print during which time the Display
will show L-P . Review this sheet in response to the next series of six
Display messages.
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The alignment sheet looks like the following example:

4 For the first alignment message, the Display will show “A” plus a number,
as, A15 . Look this number up on the alignment sheet. If the printed
lines associated with this number are aligned better than any of the other
printed lines in group “A”, press the Start button. If there is another set of
printed lines that is aligned better, press one of the Scroll buttons until
the number associated with the best aligned set appears in the Display.
Press Start.
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5 The Display will show the next number in the series, from “B” through
“F”. Repeat step 4 for these remaining five steps.

6 The Ink Cartridge alignment is completed. The Display will return to
showing 001 .
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The Xerox WorkCentre Control Program
In addition to the printer driver, the printer software also includes the Xerox
WorkCentre Control Program. The Control Program contains setup options
that define the operation of your machine.
The Control Program includes five tabs:
n

Status - Displays the printer status, ink levels, and print job status

n

Options - Includes setup options

n

Cartridges - Installs, cleans, or aligns the cartridge

n

DOS Printing - Includes settings for printing directly from DOS

n

About - Displays the Control Program version

NOTE: Select the tab menu Help button for online help with tab menu terms
and parameters.

Starting the Xerox WorkCentre Control Program
Windows 95/98 and Windows NT 4.0

1 Select Start>Programs.
2 Choose Xerox WorkCentre XK Series from the program list.
3 Select Xerox WorkCentre Control Program. The Xerox WorkCentre
Control Program window opens.

Windows 3.1x

1 From the Program Manager at system startup, open the Xerox
WorkCentre XK Series group.

2 Double-click on the Xerox WorkCentre Control Program icon. The Xerox
WorkCentre Control Program window opens.
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Xerox WorkCentre Control Program Tab Menus
When the Xerox WorkCentre Control Program on LPT1 window opens,
click the appropriate tab for the options you want to display. On the
appropriate tab, specify your changes. Click Close when you are done. Click
Help on any of the tabs to use the online Help feature.

Using the Status tab

This tab shows the printer status, ink levels, and print job status. The Status
tab includes these buttons:
n

Cancel Print – select this to cancel your print job.

n

Pause – select this to temporarily pause your print job. Select again to
restart the print job.

n

Print Test Page – select this to print a sample page.

The information area displays which job is printing, page and copy counts,
printing time, any alert/error messages and status. See graphic example
above that shows print job progress at 39% and a print time of 35 seconds.
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Cleaning the Scanning Glass
Carefully wipe the scanning glass with a SOFT, DRY CLOTH. If the glass is
very dirty, first wipe it with a slightly dampened cloth, then with a dry cloth.
Be very careful not to scratch the glass surface.
CAUTION: Never spray liquid directly onto the scanning glass.
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6. Troubleshooting
This section describes WorkCentre troubleshooting for the following problem
areas and messages:
Page

Clearing Jams................................................................. 58
Paper Jams While the WorkCentre is Printing................... 58
Tips for Avoiding Paper Jams ........................................... 59

Display Error Codes........................................................ 60
Printer Problems............................................................. 61
Print Quality Problems .................................................... 64
Paper Feeding Problems ................................................ 69
Scanning Problems (XK35c only) ................................... 71
Diagnostic Display LEDs on the Control Panel ............... 72
General Tips ................................................................... 73
Status Message Codes on the Control Panel.................. 74

Refer to the specific subsection for a description of the problem and
associated solutions.
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Clearing Jams
Paper Jams While the WorkCentre is Printing
By carefully selecting the correct paper type and loading them properly, you
should be able to avoid most paper jams. If paper jams occur, an error
message E01 appears in the Display and the paper jam Diagnostic
Display icon lights up on the Control Panel. Follow the steps below to clear
jam. To avoid tearing paper, pull the jammed paper out gently and slowly.

If Paper is Jammed in the Paper Feed Area at the Rear of the WorkCentre

1 Remove the stack of paper (if necessary).
2 Remove the jammed paper by gently
pulling it straight up as shown in the
graphic.

3 After you remove the jammed paper,
reload the stack of paper back into
the Automatic Paper Feeder with the
print side facing you. Before loading,
ensure the edges of the stack of
paper are even and straight.

4 Adjust the paper guide to match the width of the paper.
5 Press Stop.
If Paper is Jammed in the Printer Output Area
If the paper jams as it moves to the
printer exit tray, remove the jammed
paper by pulling gently on the paper as
shown in the graphic and then press
Stop.
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Tips for Avoiding Paper Jams
By carefully selecting print materials and loading them properly, you should
be able to avoid most paper jams. If jams do occur, follow the steps outlined
in Clearing Jams. If jams occur frequently, make sure that you are following
these tips to avoid jams.
n

Follow the procedures in Loading Paper to load paper properly. Make
sure the adjustable paper guides are positioned correctly.

n

Do not overload the paper. Never exceed the maximum capacity of 100
sheets of paper in the Automatic Paper Feeder.

n

Flex, fan, and straighten paper before loading it.

n

Do not load wrinkled, creased, damp, highly curled, or previously stapled
paper.

n

Do not mix paper types.

n

Use only recommended print paper. See Section 1 Getting Started/Paper
Guidelines

n

Ensure that the recommended print side is facing up when loading paper
into the feeder.

n

Store print materials in an acceptable environment.

NOTE: If the remedies described above do not eliminate the error code in the
Display and you are sure that no paper remains in the paper path, do the
following:
Turn off the power switch, pull the power cord from the wall outlet, wait for at
least one minute, then insert the power cord back into the wall outlet. Turn
the power switch on. The machine should be at the normal standby mode.
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Display Error Codes
The following error codes appear in the Control Panel Display when your
machine has a problem. Use it to identify and solve problems.
LED

Meaning

Solution

E01 .

Paper is jammed
inside the unit, or
the paper feeder is
empty.

n

Remove jammed paper from
the paper feeder or the paper
exit tray, and press Stop.

n

If there is no paper in the
paper feeder, load and press
Stop.

n

If there is paper in the paper
feeder, remove the paper, then
reload paper and press Stop.

E02 .

No left cartridge

Install the color ink cartridge. See
Installing the Ink Cartridges.

E03 .

No right cartridge

Install the black ink cartridge. See
Installing the Ink Cartridges.

E04 .

One of the ink
cartridges is not
installed correctly.
See CAUTION.

Push each ink cartridge firmly
toward the back of the machine
until it snaps into place and press
Stop.

E05 .

One or both
cartridges are not
in good condition.

n

Align the ink cartridges. See
Aligning the Ink Cartridges.

n

Clean the cartridge nozzles
and contacts. See Wiping the
Print Nozzles and Contacts.

n

Replace the ink cartridges.
See Replacing the Ink
Cartridge.

CAUTION: Non-Xerox ink cartridges will not fit correctly into the
WorkCentre cartridge compartment.
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Printer Problems
Symptom

Cause and Solution

The printer does not
print.

n

The USB or parallel cable is not
connected properly.

n

The USB or parallel cable is defective.
Swap the cable with one known to work.
If necessary, replace the cable.

n

If using a parallel cable, ensure that it is
compliant with the IEEE 1284 standard.

n

The printer port is configured incorrectly.
Check Printer Setting in Windows to
make certain that the print job is being
sent to the correct port (for example,
LPT1).

n

A paper jam has occurred. See Section
6 Troubleshooting/Clearing Jams.

n

The printer may be configured incorrectly
within the PC application. Check the
application to verify that all print settings
are correct.

n

The printer driver may be incorrectly
installed. Remove the existing printer
driver, and re-install the printer driver.
See Section 1 Getting
Started/Uninstalling Software. Try
printing a test page.

n

Paper has not been loaded properly.
Remove and re-insert the paper
correctly. See Section 1 Getting
Started/Loading Paper.

n

There is too much paper in the Automatic
Paper Feeder. Remove some paper.

The paper does not feed
into the printer.
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Printer Problems (continued)
Symptom

Cause and Solution

Part of the printed page
is blank.

n

The page layout is too complex. Simplify
the page layout, and remove any
unnecessary graphics from the
document.

n

The page orientation setting may be
incorrect in the print driver. Change the
page orientation in the Print Setup dialog
box.

n

The paper size and the software paper
size settings do not match. Load the
correct paper in the printer or change the
software paper size settings in the Print
Setup dialog box.

n

Scaling may be set to less than 100%.
Change the scaling setting in the
Paper/Output dialog box.

n

The printer cable may be incorrect.
Replace the cable with a correct cable.
See Section 1 Getting Started/Setup.

n

One of the ink cartridges may be empty.

n

The printer cable may be connected
improperly. Check the cable connection.

n

There may be a problem with the printer
driver software. Exit Windows and reboot
the computer. Turn the printer off and on.

n

The printer cable may be incorrect.
Replace the cable with a correct cable.
See Section 1 Getting Started/Setup.

The printer prints the
wrong data, or it prints
incorrect characters.
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Printer Problems (continued)
Symptom

Cause and Solution

The paper constantly
jams.

n

There is too much paper in the Automatic
Paper Feeder. Remove some of the
paper. If printing onto transparencies or
labels, insert them one at a time in the
Manual Paper Feeder.

n

An incorrect type of paper is being used.
Use only paper that meets the
specifications required by the printer.
See Section 1 Getting Started/Paper
Guidelines.

n

The paper setting method may be
incorrect. If printing onto envelopes,
insert the envelopes so that there is a
gap of approximately 1 mm (1/32")
between the left and right edges of the
envelopes at the paper guide.

n

If using Windows 3.1, Print Manager may
be disabled. From the Control Panel
Printers menu, check the Use Print
Manager box.

n

If using Windows 3.1, the Background
Printing item in the Option menu of Print
Manager may be set incorrectly. Select
Background Printing from the Option
menu in the Print Manager.

n

If using Windows 95/98/NT 4.0, the
Spooling Setting may be set incorrectly.
Select Start > Settings > Printers. Click
the WorkCentre icon with the right mouse
button, select Properties, click the
Details tab, and then click the Spool
Settings button. Select the desired spool
setting from the available choices.

Printing is too slow.
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Print Quality Problems
Symptom

Cause and Solution

Light or blurred
characters.

n

You may be using Draft quality or Normal
quality mode. Try using High 1200 dpi
print quality mode.

n

The print cartridge may be running out of
ink. Replace the print cartridge. The PC
Control Program Status Monitor shows
the amount of ink left in the cartridge.

n

Make sure you are using the correct type
of paper. Try another type of paper. See
Section 1 Getting Started/Paper
Guidelines.

n

You may be printing on the wrong side of
the paper.

n

The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

Solid black areas on
transparencies contain
white streaks.

Try changing the fill pattern in your
application software. The print head may
need cleaning. See Section 5
Maintenance/Print Head Nozzle procedure.

Smudged or dark
characters.

n

Make sure you are using the correct type
of paper. Try another type of paper.
Make sure the paper is straight and
unwrinkled.

n

Let ink dry before handling the paper.
You can use ‘Dry Time Delay’ check box
in the print driver setting. Change the
Print Quality setting to Normal quality
mode. The print head may need
cleaning. See Section 5
Maintenance/Print Head Nozzle
procedure.
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Print Quality Problems (continued)
Symptom

Cause and Solution

Characters with white
lines

n

The print cartridge may be running out of
ink. Replace the print cartridge. The
Status monitor shows the amount of ink
left in the cartridge.

n

Remove and reinstall the print cartridge.
See Section 5 Maintenance/Replacing
the Ink Cartridge.

n

The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

n

If printing on transparencies, try changing
the fill pattern in your application
software.

n

The media is incorrectly loaded or is an
unsupported size or type. See Section 1
Getting Started/Paper Guidelines. For
special media, it is recommended to feed
one sheet at a time.

n

Make sure you do not have hard-coded
spaces at the left margin in your
application.

n

The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

n

The print cartridge may be mis-aligned.
See Section 5 Maintenance/Cartridge
Alignment.

Incorrect format or
characters do not align
correctly at left margin.
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Print Quality Problems (continued)
Symptom

Cause and Solution

Vertical straight lines are
not smooth in tables,
borders, and graphs.

The print cartridge may be mis-aligned.
See Section 5 Maintenance/Cartridge
Alignment.

Printed color does not
match screen colors.

n

The color print cartridge has run out of
one or more inks. Install a new cartridge.
See Section 5 Maintenance/Replacing
the Ink Cartridge.

n

The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

n

The print settings may be incorrect.
Check Document Type setting in the
Document/Quality dialog in the print
driver.

n

A black cartridge may be installed
instead of a color cartridge. Replace with
a color cartridge. See Section 5
Maintenance/Replacing the Ink Cartridge.

Black and white is
printing instead of
expected color printing.
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Print Quality Problems (continued)
Symptom

Cause and Solution

Color print quality is
poor.

n

Ensure that you are using the correct
type of paper. See Section 1 Getting
Started/Paper Guidelines.

n

Ensure that the Media/Paper Type
setting in the print driver is correct for the
type of paper loaded.

n

Change the Print Quality setting in the
print driver to High or Normal

n

The printer is improperly connected to
the computer. Make sure the printer
cable is firmly connected to the printer
and the computer.

n

Make sure the printer cable is correct.
See Section 1 Getting Started/Setup.

n

Bad printer cable or computer port. Try
another cable. See Section 1 Getting
Started/Setup.

n

Make sure your application has the
WorkCentre selected as the default
printer.

n

Check the print cartridge. Tape may be
covering the ink nozzles of the print
cartridge.

n

The print cartridge may be out of ink.
Replace with a new one. See Section 5
Maintenance/Replacing the Ink Cartridge.
The PC Control Program Status Monitor
shows the amount of ink left in the
cartridge.

n

Clean the cartridge carrier contacts. See
Section 5 Maintenance/Cleaning Carrier
Contacts.

Printer power is on, but
nothing prints.

Printer seems to be
printing, but no
characters are printing.
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Printer Quality Problems (continued)
Symptom

Cause and Solution

Unexpected characters
are printed or characters
are missing.

n

Make sure your application has the
WorkCentre selected as the default
printer.

n

The printer cable may not be securely
connected to the printer and the
computer, or the printer cable may not he
correct type. Check the printer cable.

n

The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

n

You may be using High 1200 dpi print
quality. Change the Print Quality setting
in the print driver to Normal.

n

Graphics print more slowly than text.

n

Color prints more slowly than black.
Special media prints more slowly than
plain paper.

n

Another application currently open affects
print speed. Close the running program if
not required.

Printer prints very
slowly.

Control panel of your
machine does not
respond.

Page does not print.
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1) Turn power switch off, then on. If this
does not work, try step 2.
2) Unplug the power cord, wait one minute,
then plug in the machine.
Simplify the page format or use fewer fonts.
Some complicated page formats may not
be printable on the printer. If you are using
too many fonts, or printing complex
graphics, you can experience this problem.

Paper Feeding Problems
Symptom

Cause and Solution

Paper is jammed during
printing.

Clear the paper jam. See Section 6
Troubleshooting/Paper Jams While the
Machine is Printing.

Paper sticks together.

n

Ensure there is not too much paper in the
Automatic Paper Feeder. Depending on
the thickness of your paper, the feeder
can hold up to 100 sheets of paper.

n

Make sure you are using the correct type
of paper. See Section 1 Getting
Started/Paper Guidelines.

n

Remove paper from the feeder and flex
or fan the paper.

n

Humid conditions may cause some paper
to stick together.

n

Make sure the envelope guide is not in
the upright position.

n

Remove any obstructions inside the
machine.

n

Different types of paper may be stacked
in the Automatic Paper Feeder. Load the
paper of only one type, size, and weight.

n

When loading paper, do not force the
paper down into the printer.

n

If multiple sheets have caused a paper
jam, clear the paper jam. See Section 6
Troubleshooting/Clearing Jams.

Paper fails to feed.

Multiple sheets of paper
do not feed.
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Paper Feeding Problems (continued)
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Symptom

Cause and Solution

Paper skews or buckles

n

Ensure there is not too much paper in the
Automatic Paper Feeder. Depending on
the thickness of your paper, the feeder
can hold up to 100 sheets of paper.

n

Make sure the paper guide does not
cause the paper to bow in the Automatic
Paper Feeder.

n

Make sure you are using the correct type
of paper. See Section 1 Getting
Started/Paper Guidelines.

n

When loading paper, do not force the
paper down into the machine.

n

Make sure the right side of the paper is
aligned with the right edge of the feeder,
and the left paper guide is set against the
left side of the paper.

n

Make sure the envelope guide is not in
the envelope position.

Transparencies stick
together in the paper
exit.

Use only the transparencies specially
designed for an ink jet printer. Remove
each transparency as it exits from the
printer.

Envelopes skew or fail to
feed correctly.

n

Ensure that the envelope guide has been
turned upright to the envelope load
position.

n

Ensure that the paper guide is against
the left side of the envelopes.

Troubleshooting

Scanning Problems (XK35c only)
Symptom

Cause and Solution

The scanner does not
scan.

n

Make sure you place the document to be
scanned face down on the document
glass.

n

There may not be enough available
memory to hold the document you want
to scan. Try the Pre-Scan function to see
if that works. Try lowering the scan
resolution rate.

n

The USB or parallel cable is not
connected properly.

n

The USB or parallel cable is defective.
Swap the cable with one known to work.
If necessary, replace the cable.

n

If using a parallel cable, ensure that it is
compliant with the IEEE 1284 standard.

n

The scanner is configured incorrectly.
Check scanner setting in scanner driver
to make certain that the scanner job is
being sent to the correct port (for
example, LPT1).

n

Graphics are scanned more slowly than
text.

n

Communication speed becomes slow in
scan mode because of the large amount
of memory required to analyze and
reproduce the scanned image. Set your
computer to ECP printer mode through
BIOS setting. It will help to increase the
speed. For details on how to set BIOS,
refer to your PC documentation.

The unit scans very
slowly.
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Scanning Problems (continued)
Symptom

Cause and Solution

The following message
appears on the computer
screen: Scanner is busy
receiving or printing
data. When the current
job is completed, try
again.

There may be a copying or printing job in
progress. When the current job is
completed, try the job again.

Diagnostic Display LEDs on the Control Panel
There are three diagnostic conditions that may occur in the WorkCentre.
When any one of these Diagnostic Display LED lights turns on, refer to this
table.
LED Light
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Meaning

Solution

The color ink
cartridge has a
low ink supply.

Replace the color ink cartridge. See
Section 5 Maintenance/Replacing
the Ink Cartridge.

The black
cartridge has a
low ink supply.

Replace the black cartridge. See
Section 5 Maintenance/Replacing
the Ink Cartridge.

A paper jam has
occurred inside
the machine or the
paper feeder is
empty.

n

Remove the jammed paper from
the paper feeder or the paper
exit tray, and press Stop.

n

If there is no paper in the paper
feeder, load paper and press
Stop.

n

If there is paper in the paper
feeder, remove the paper form
the feeder, the reload the paper
and press Stop.

General Tips
Installation
When installing the WorkCentre printer and scanner drivers, close all
open programs first.
Improved results can be obtained by installing the WorkCentre drivers
and Control Program software first before you install the Pagis Pro and MGI
PhotoSuite software.
Use a direct connection (single cable) between your PC and the
WorkCentre to avoid communications problems. Do not use an A/B printer
switch or a pass-through port (as, a zip drive).

Performance
When running a memory intensive function (as, scanning), better and
faster results can be achieved by closing any open programs (as,
screensavers and other background applications.
If any hangup or freeze-up occurs in the PC or WorkCentre, try
rebooting the PC or turning the WorkCentre off, then on (pulling the AC
power cord from the AC outlet, then re-inserting the cord).
If a paper jam occurs, and the error code E01 does not clear after
removing the jam, pull the WorkCentre power cord from the outlet, wait one
minute, then plug the cord in again. The Display should show 001.
If scanning does not work, try reducing the resolution rate.
When using Clone for copying, if the number of images is not copied as
expected, the original image size may be too large. Try reducing the image
size before copying. Also try shifting the image document on the platen to
different locations (as, the home registration marks).

Customization
To have the WorkCentre Control Program run in a minimized mode,
select Start>Programs>Xerox WorkCentre XK Series> Printer Control
Program>Options, then check “run minimized”.
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Status Message Codes on the Control Panel
The following codes provide information on the current status of the machine.
These codes appear in the Control Panel Display.
Mode

Code

Descriptions

Standby

001

Standby mode

Copy

025 to 400

Copy size (reduction. enlargement)

001 to 050

Copy quantity

U01

Change cartridge

U02

Align cartridge. L-P appears in the Display as
the alignment sheet is printed.

Menu

A00 to A30

Horizontal alignment

b00 to b15

Vertical alignment

C00 to C30
d00 to d30

Quick color bi-directional alignment

E00 to E30

Normal monochrome bi-directional
alignment

F00 to F30

Normal color bi-directional alignment

U03
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Quick monochrome bi-directional alignment

Set paper size:
P01

Letter

P02

A4

P03

Legal

U04

Ink nozzle self test/cleaning

PC Scan

PCS

Scanning has been initiated from PC (XK35c
only)

PC Print

PCP

Printing has been initiated from PC

Cartridge
change

L-C

Left cartridge (color) changed?

r-C

Right cartridge (black) changed?

bsy

The machine is busy. Replace the cartridge
after the current job is done.
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Appendix
Machine Specifications
Scanner (XK35c only)
Item

Specification

Operating System

Windows 3.1x, Windows95/98/NT 4.0

Interface

IEEE 1284 (ECP Support), USB (without
HUB Mode)

Compatibility

TWAIN Standard

Device

Platen Color CIS (Contact Image Sensor)

Scan Width

Max. 8.5” (216 mm), Effective 8.2” (210 mm)

Color Depth

Internal 30 bit, External 24 bit

Optical Resolution (H x V)

300 x 600 dpi

Interpolation Resolution

Maximum 4800 dpi

Pre-scan Mode

Yes, 75 dpi

Minimum PC spec

486DX, 100 MHz, 16 MB memory, 20 MB
free disk space

Recommended PC spec

Pentium II, 200 MHz, 32 MB memory, 20 MB
free disk space
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Printer
Item

Specification

Technology

Color Thermal Inkjet

Engine Type

2-Pen (K and CMY)

Operating System

Windows 3.1x, Windows 95/98/NT 4.0

Interface

IEEE 1284 (ECP Support), USB (without
HUB Mode)

Emulation

HBP (GDI)

Print Speed

Print Resolution
(H x V)
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Mono

8 ppm draft, 5 ppm normal

Color

3 ppm draft, 1.5 ppm normal

Draft

300 x 600 dpi

Normal

600 x 600 dpi

Best

1200 x 1200 dpi (addressable)

Maximum Paper Size

A4/Letter/Legal

Effective Printing Width

8.0” (203 ± 1 mm)

Output Tray Capacity

Maximum 50 sheets

Input Paper Capacity

Maximum 100 sheets (20 lb. paper)

Maximum Printer Cable
Length

6 ft. / 1.8 m.

Minimum PC spec.

486DX, 100 MHz, 16 MB memory, 20 MB
free disk space

Recommended PC spec.

Pentium II, 200 MHz, 32 MB memory, 20
MB free disk space
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Copier
Item

Specification

Copy Mode

Black and Color

Scanner Type

Flat-bed without ADF (Automatic
Document Feeder)

Maximum Original size

A4/Letter

Maximum Paper Size

A4/Letter/Legal

Maximum Scan Width

8.5” (216 mm)

Optical Resolution (H x V)

300 x 600 dpi

Copy Quality

Draft, Normal, Best

Mono Copy Speed (A4)

Draft: 3 cpm, Normal: 2 cpm

Color Copy Speed (A4)

Draft: 1.5 cpm, Normal: 0.5 cpm

Effective Print-edge Margin

Top: 1/8” (3.4 mm),
Bottom: 3/4” (19.05 mm),
Each side: ¼” (6.5 mm)

Multicopy

50 pages

Reduction and Enlargement

25% to 400% (1% increments)

Fixed R/E Settings

100%, AutoFit, Clone (multiple images)

Contrast Control

3 steps

Ink Saver Mode

Use Draft Mode

Auto Sensing

Check Paper (paper jam or no paper),
Low ink
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General Specifications
Item

Specification

Rated AC power input

110 to 240V AC (Universal)

Average power
consumption

Under 15W (Standby)
Under 50W (Copy Mode)
Under 35W (Scan/Print Mode)

Machine Size

17.4” x 18.1” x 8.5” / 44 x 46 x 21 cm.

Machine Weight

18 lbs. / 8.25 kg. (machine without paper)

Operating Condition

Temperature

5 to 40 C
o
o
(40 to 104 F)

Humidity

20% RH to 80% RH

Temperature

16o to 32o C
(60o to 90o F)

Humidity

40% RH to 70% RH

Color #8R12591

Black #8R7881

Recommended
Operating Condition

Inkjet Cartridge Part
Numbers
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Media Specifications
Sizes
Type

Width x Length
(mm x mm)

Width x Length
(inch x inch)

Letter

216 x 279

8.5 x 11

Legal

216 x 356

8.5 x 14

B5

182 x 257

7.2 x 10.1

A4

210 x 297

8.3 x 11.7

Executive

184 x 267

7.25 x 10.5

A5

148 x 210

5.8 x 8.3

A6 Card

105 x 148

4.1 x 5.9

Post Card 4x6

102 x 152

4x6

Index Card 3x5

76 x 127

3x5

Hagaki

100 x 148

5.8 x 8.3

Envelope 7 ¾

98 x 190

3.9 x 7.5

Envelope 9

98 x 225

3.9 x 8.9

Envelope 10

105 x 241

4.,1 x 9.5

Envelope DL

110 x 220

4.3 x 8.7

Envelope C5

162 x 229

6.4 x 9

Envelope C6

114 x 162

4.5 x 6.4

Envelope B5

176 x 250

6.9 x 9.8

Baronial

143 x 111

5.6 x 4.4

Custom

76.2 to 215.9 x

3.00 to 8.50 x

127.0 to 355.6

5.00 to 14.00
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Media Specifications (continued)
Feeding by Media Type
Paper Type

Feeding Method

Normal copying paper

Auto Feed

Inkjet Paper

Auto Feed

Transparency

Auto Feed

Coated paper

Auto Feed

Label

Manual Feed

Envelope

Auto Feed (use envelope guide)

Ordinary card

Auto Feed (use envelope guide)

T-shirt paper

Manual Feed

Ordinary postcard

Auto Feed (use envelope guide)

The following media types are unusable:

80

Appendix

n

Erasable bond paper

n

Synthetic paper

n

Thermal reactive paper

n

Multi-paged paper

n

Embossing paper

n

Envelopes with cutting lines, perforated paper, embossed paper,
contents or self-adhesive envelopes.

n

Label paper with slick back

n

Auto Feed media weights greater than:
l

24 lb. for paper and envelopes

l

150 lb. for card stock

FCC Regulations: Radio Frequency Emissions
European Union:
Changes or modifications to this equipment not specifically approved by Xerox
Europe may void the user’s authority to operate this equipment.
Shielded cables must be used with this equipment to maintain compliance with
the EMC Directive (89/336/EEC).
United States of America:
Note: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of
the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for
help.
Changes or modifications to this equipment not specifically approved by the
Xerox Corporation may void the authority granted by the FCC to operate this
equipment.
This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.
Contact Person:
Phone:
Address:

Gary E. Myers
(716) 422-4120
Xerox Corporation
800 Phillips Road
Webster, New York 14580
USA
Shielded cables must be used with this equipment to maintain compliance with
FCC regulations.
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Index
3

Copy, x, 6, 13, 35, 37-40, 74, 77
Making One Quick Copy, 35, 37
Custom, 79

3-hole paper, 14

A
About, 29, 54
Alert, 55
Alignment, See Ink cartridge:align
Alignment sheet, 13, 52, 74
APF. See Automatic Paper Feeder
Application, 15, 16, 24, 26-28, 61, 64, 65, 67, 68
Automatic Paper Feeder, 1, 3, 8, 11, 13-16, 45,
46, 49, 58, 59, 61, 63, 69, 70, 80

B
Bi-directional, xii, 9, 74

C
Cable, xii, 2, 9, 61, 62, 67, 68, 72
Calling for Service and Supplies, ix, 2
Cancel, 7, 55. See also Stop
Cartridge. See Ink cartridge
Cartridge alignment. See Ink cartridge:aligning
Cleaning the Scanning Glass, 43, 56
Closure Button
Cancel, 7, 29, 55
Help, 22, 29, 54, 55
OK, 23, 26, 29, 32, 51
Color, ix, 6, 27-29, 35-38, 40, 67, 68, 75-78
Intensity, 35, 38
Components, 1, 2
Configuration, xii
Contrast, 5, 35, 36, 38, 77
Control Locations, 1, 3, 4
Control Panel, 1, 3-5, 10, 11, 15-18, 27, 41, 45,
50, 51, 57-60, 63, 73, 74
Control Program, xii, 11, 22, 26, 43, 46, 51, 54, 55,
64, 67
Copies, 6, 29, 35, 36, 39, 41

D
Default, 28, 29
Printer, 23, 26, 27, 67, 68
settings, 7, 29
Diagnostic Display LEDs, 5, 49, 57, 72
Display, 2, 3, 5-7, 10-14, 17, 18, 26, 32, 33, 37,
40, 41, 45, 47-49, 51, 52, 53, 57-60, 73, 74
Documentation, 9, 22, 26, 71
DOS, 26, 54

E
Editor, xii, 33
Enlarging, 35, 40
Envelopes, 14, 15, 19, 63, 70, 79, 80
Error, 6, 10, 14, 55, 58-60, 72
Codes, 57, 60
Exit, 8, 29, 58, 60, 62, 70, 73
Exit tray, 8, 58, 60, 73
Extender, 8

F
FCC, 81
Feeder. See Automatic Paper Feeder or Manual
Paper Feeder
File, 23, 26, 28, 32
Finishing, 28, 29
Fixed, 77
Fold, 14
Folder, 28, 29
Font, 68
Format, 65, 68
Function, xii, 17, 31, 32, 33, 37, 41, 45, 71

G
GDI, 76

Index

1

H

Model, ix, xi
Mouse, 28, 63

Help, 8, 54, 71, 81. See also Closure Button
Helpful Hints, viii. See also Tips
Horizontal, 74

O
Open, 8, 11, 37, 51, 59
Owner, x

I
IEEE 1284, xii, 4, 9, 61, 72, 75, 76
Image, xii, 5, 29, 33, 34, 36, 39, 40, 44, 71
Index, 79
Ink cartridge, ix, xii, 1, 2, 4, 10-13, 17, 43, 44, 4650, 53, 60, 62, 65-67, 73
aligning, 1, 10, 11, 17
changing, 17
cleaning, v, viii, 7, 17, 43, 45, 47, 48, 64-66,
68, 74
install, 11
replace, 49
Insert, 12, 23, 50, 72
Installation, vi, xii, 1, 11, 22, 23, 44, 81
Intensity, 35, 38
Iron-on. See Paper:iron-on
It’s Illegal, x

J
Jams. See Paper jams
Job, 28, 29

L
Label, 80
Landscape, 14
LED Window. See Display
Limit, 81
Loading
envelopes, 1, 15
paper, 1, 14, 59, 61
LPT1, 46, 51, 54, 55, 61

M
Machine Specifications, 75
Maintenance, 11, 13, 17, 18, 22, 26, 43, 64-68, 73
Manual Feed, 80
Manual Paper Feeder, 1, 3, 14, 16, 63
Margin, 77
Media, viii, 1, 5, 14, 15, 16, 19, 21, 39, 65, 67, 68,
79, 80
Specifications, 79, 80
Type, 5, 39, 80
Memory, 71, 75, 76
Menu
button, 11, 17, 18, 41, 45, 48, 49, 51
Features, 35, 37, 38
Message. See Status:Message Codes

2

Index

P
Paper, 1, 3, 5-8, 11, 14-21, 26, 27, 29, 36, 37, 39,
45, 46, 49, 51, 58-64, 67, 68, 69, 70, 73, 74, 77,
78, 80
coated, 5, 20, 21, 80
glossy photo, 1, 21
greeting card, 20
guidelines, 1, 19, 59, 63-65, 67, 69, 70
iron-on, 20
jams, 57, 58, 59, 69
avoiding, 57, 59
Selection, 1, 20
Size, 1, 18, 76, 77. See also Media
Specifications
Paper Specifications. See Media Specifications
Parallel, xii, 9, 61, 72
Parameter, 29
Part numbers, ix, 78
Pause, 55
Port, xii, 4, 9, 10, 29, 61, 67, 72
Portrait, 14, 20
Position, 50, 69, 70
Postcard, 80
Print
driver, xii, 22, 23, 26, 27, 29, 32, 33, 34, 54,
61, 62, 64, 66-68
job, 15, 16, 26, 27, 29, 54, 55, 61
Quality, 57, 64-68
Test Page, 55
Printer
Properties, 25, 29
Settings, 25-28
Printing, 21, 25, 26, 54, 57, 58, 63, 69, 74, 76
Problem, 14, 44, 47, 57, 60, 62, 68, 72
paper feeding, 57, 69, 70
print quality, 57, 64-67
printer, 57, 61, 62, 63
quality, 57, 64-68
scanning, 57, 71, 72

R
Reducing. See Enlarging
Registration, xi
Relative, 21
Remedy, 59
Replacing ink cartridge, See Ink cartridge:replace
Requirement, v, xii
Resolution, 5, 33-38, 71, 75-77

S
Safety Notes, v, vi, vii
Save, xi, 33
As, 33
scaling, 62
Scanner, xii, 3, 4, 11, 12, 17, 22, 31-34, 43, 47,
48, 49, 56, 57, 71, 72, 74, 75, 77
Selecting Media Type, 39
Service, ix, 2, 48
Setting paper size, 17
Settings, 7, 25, 26-29, 34, 38, 54, 61-63, 66, 77
Special Features, 35
Setup, 1, 8, 10, 23, 26, 28, 54, 62, 67
Size, 1, 6, 13, 18, 40, 76, 77, 78. See also
Paper:Size
Software, 1, 22, 24, 26, 61
installation, 1, 22, 26, 32
Specifications, 19, 75, 78-80
Status, 6, 54, 55, 74
Message Codes, 57, 74
Stop, 7, 12, 40, 41, 49, 60, 73
Supplies, ix, 2

T

Tips, 73
Transparencies, 14, 20, 39, 63-65, 70, 80
Troubleshooting, 57
T-shirts. See Paper:iron-on

U
Uninstall, vi, 8, 21, 24, 29, 44, 46, 49, 58-60, 62,
72, 73

V
Version, 29, 54
Vertical, 66, 74

W
Windows 3.1x, xii, 23, 24, 27, 28, 54, 75, 76
Windows 95/98, xii, 23, 25, 27-29, 46, 54, 63, 76
Windows NT 4.0, 25, 27, 28, 46, 54
www.xerox.com, ix

X
Xerox, vii, viii, ix, xi, xii, 2, 22, 25, 26, 28, 31, 32,
35, 43, 46, 48, 51, 54, 55, 81
Xerox SupplyNet, ix

Test, 7, 13, 17, 20, 44-48, 51, 55, 61, 74
Page, 55
print, 51
Timeout, 29
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